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1 Introduction
This application note describes how to modify a Kinetis 
Motor Suite (KMS) project to use a Kinetis V series 
microcontroller (MCU) with custom hardware.

By default, KMS is configured to work with the motor 
control development platforms listed in Table 1:

By using an NXP platform with known characteristics, KMS 
is able to spin your motor quickly, allowing you to evaluate 
the solution in a working electromechanical system. 

However, when you reach the stage of your design cycle 
where you are ready to design a Kinetis V MCU into your 
application, you must adapt KMS software to account for 

Table 1. KMS-enabled development platforms

Platform Power Stage Control Board

Freedom FRDM-MC-LVPMSM FRDM-KV11Z
FRDM-KV31F

Tower TWR-MC-LV3PH TWR-KV11Z75M
TWR-KV31F120M

High Voltage HVP-MC3PH TWR-KV11Z75M
HVP-KV31F120M
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your custom hardware. This typically involves adapting to different circuitry as well as to a different MCU 
part number from the version used on the reference Control Boards.

This can be accomplished with a series of changes made through the KMS GUI and in your KMS 
embedded software reference project. The process is summarized in Table 2.

This application note explains these steps.

WARNING

When using any KMS-enabled MCU, it is critical to avoid mass erase 
from prototyping through production. Mass erase eliminates 
preprogrammed proprietary code that cannot be restored by the user. Keep 
this in mind when using this app note and refer to the KMS Release Notes 
for supported debug configurations that minimize the risk of mass erase.

In addition, new flash commands have been added. One of these is "Erase 
All Execute-only Segments" (Flash command 0x4B). This command should 
never be executed as it would erase the KMS library and render the MCU 
non-functional for KMS operations.

Table 2. Steps to adapt to custom hardware

Section Step KMS Component(s)

Section 2, Configuration 
from KMS GUI

Spin your motor on evaluation hardware  • Motor Tuner

Define ADC settings  • Motor Manager

Define PWM settings

Define additional settings

Update motor drive configuration

Section 3, Configuration 
from KMS project

Update SDK libraries  • Motor Observer

Change MCU-specific settings

Modify FlexTimer pins

Modify ADC pins

Modify UART pins

Modify gate drive interface [optional]

Section 4, Verification 
from KMS GUI

Verify DC bus and offsets  • Motor Observer
 • GUI - Motor Manager

Verify PWM operation  • GUI - Motor Manager
 • GUI - Software Oscilloscope

Verify phase currents  • GUI - Motor Manager
 • GUI - Software Oscilloscope

Validate that motor spins on custom 
hardware

 • GUI - Motor Tuner
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NOTE

The MCU on your development platform hardware may not be identical to 
the MCU provided by NXP as production silicon. A feature has been added 
to aid you in protecting the KMS preprogrammed proprietary code in the 
flash. This feature allows the use of the FSEC[MEEN] bits to avoid mass 
erase when the MCU is non-secure. Evaluation hardware built in 2015 does 
not have this feature. Refer to the MCU errata documents and MCU 
Reference Manuals for details of the implementation details of this and 
other MCU features.

2 Configuration from KMS GUI

2.1 Spin your motor on evaluation hardware

KMS gets your motor up and running by walking you through Motor Tuner, a wizard-style PC GUI that 
automatically identifies and tunes key values for your motor system.This is described in detail in the KMS 
User’s Guide and KMS Lab Guide.

Once your motor is operating to your satisfaction on the evaluation hardware, you can begin to adapt the 
configuration settings in the KMS GUI to your custom hardware. This transition can begin as soon as you 
have successfully completed Motor Tuner, or after you have optimized your motor control settings or 
constructed your application’s motion sequence.

2.2 Define ADC settings

The first key step is to modify the analog to digital (ADC) hardware using the KMS GUI. Most of these 
settings can be calculated based on the analog sensing circuitry of your design. This app note uses the 
TWR-MC-LV3PH, HVP-MC3PH, and FRDM-MC-LVPMSM as examples.

Navigate to the KMS GUI’s expert mode, known as Motor Manager, and find the Protection & Hardware 
tab. On this page there is a section titled “Hardware Configurations.” Here you can find the following 
settings for the ADC hardware.

Figure 1. ADC settings in KMS GUI (default values for TWR development platform)
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2.2.1 Maximum DC bus

This is the value of the DC bus when the ADC reads 3.3 V. It is based on the voltage divider used to scale 
the DC bus into a value that can be read by ADC hardware.

The DC bus measuring circuit for the TWR-MC-LV3PH, is shown in Figure 2.

Figure 2. TWR-MC-LV3PH DC bus measuring circuit

A simple voltage divider is used to scale the DC bus into a measurable voltage. According to the voltage 
divider equation (Equation 1):

Vout = (1.5 kOhms + 1.5 kOhms) / (1.5 kOhms + 1.5 kOhms + 30.0 kOhms) * Vin. Eqn. 1

This equation can be rearranged so that Vin can be calculated based on Vout. In this case, the Vout needs to 
be 3.3 V since that is the maximum ADC reading. The equation now becomes Equation 2:

Vin = (1.5 kOhms + 1.5 kOhms + 30.0 kOhms) / (1.5 kOhms + 1.5 kOhms) * 3.3 V Eqn. 2

Which means Vin is 36.3V when Vout is 3.3 V.

This same analysis can be applied to the HVP-MC3PH which uses the DC bus measuring circuit in 
Figure 3.
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Figure 3. HVP-MC3PH DC bus measuring circuit

Vin = (1.5 kOhms + 1.5 kOhms + 3 * 130.0 kOhms) / (1.5 kOhms + 1.5 kOhms) * 3.3 V Eqn. 3

Which means Vin is 432.3V when Vout is 3.3 V.

This same analysis can be applied to the FRDM-MC-LVPMSM which uses the DC bus measuring circuit 
in Figure 4.
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Figure 4. FRDM-MC-LVPMSM DC bus measuring circuit

Vin = (3 kOhms + 52.3 kOhms) / (3 kOhms) * 3.3 V Eqn. 4

Which means Vin is 60.83V when Vout is 3.3 V.

2.2.1.1 Selecting the appropriate maximum DC bus

The ideal maximum DC bus value should give plenty of margin around the expected DC bus of the 
application. Typically, at least 25% headroom should be added. This is done to prevent the possibility that 
the DC bus is so large that the microcontroller cannot read it. If the microcontroller does not have an 
accurate read of the DC bus voltage, it can cause problems with the control algorithm potentially applying 
too much voltage to the motor. Additionally, overvoltage protection will not function properly and could 
results in hardware damage.

The recommendation is to choose the maximum DC bus to be 25% larger than the nominal DC bus.

Once a maximum DC bus value has been selected, the voltage divider resistors should be selected so that 
when the ideal maximum DC bus is provided, the ADC voltage is 3.3 V.

2.2.2 Maximum phase current

The maximum phase current is the value of the motor phase current when the ADC reads 3.3 V. Typically 
this is measured using a shunt resistor in line with the leg of the inverter. The voltage drop across this 
resistor is measured and amplified, and when combined with the value of the resistance, produces a current 
signal. These signals are offset by 1.65 V (3.3 V / 2), so that both positive and negative currents can be 
measured.

On the TWR-MC-LV3PH, a 0.05 Ohm resistor is placed in line with the leg of the inverter. This is shown 
in the circuit diagram in Figure 5.
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Figure 5. TWR-MC-LV3PH inline resistor

The signals I_SENSE_C1 and I_SENSE_C2 are provided to this circuit to convert the signals into a signal 
that can be read by the ADC. The circuit used is shown in Figure 6.
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Figure 6. TWR-MC-LV3PH signal conversion circuit

This is a non-inverting differential amplifier circuit. The gain of this amplifier can be described as R65 / 
(R63 + R64). That gain is applied to the voltage drop across the phase current sense resistor. The ADC 
signal can be described by Equation 5:

VADC = (Iphase * Rphase) * (R65 / (R63 + R64)) + Voffset Eqn. 5

This can be rearranged so that the Iphase can be calculated based on the VADC. Substituting the values, we 
arrive at Equation 6:

Iphase = (3.3 V - 1.65 V) * (1600 Ohms + 220 Ohms)/(7500 Ohms * 0.05 Ohms) Eqn. 6

Which means Iphase is 8.008 A when VADC is 3.3 V. 

The circuits and analysis are identical on the HVP-MC3PH.

The FRDM-MC-LVPMSM uses the current sensing circuit shown in Figure 7.
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Figure 7. FRDM-MC-LVPMSM inline resistor and signal conversion circuit

This is also a non-inverting differential amplifier circuit. In this case, the inline sense resistor is 0.02 Ohm. 
Using Equation 6 and substituting in the value for the FRDM-MC-LVPMSM, we arrive at Equation 7.

Iphase = (3.3 V - 1.65 V) * (1000 Ohms)/(10 kOhms * 0.02 Ohms) Eqn. 7

Which means Iphase is 8.25 A when VADC is 3.3 V.
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2.2.2.1 Selecting the maximum phase current

The ideal maximum phase current needs to be selected more carefully than the maximum DC bus. This is 
due to its importance when controlling the motor. The maximum phase current needs to be the smallest 
possible value that is still larger than the expected maximum value the system will see. This will give your 
microcontroller the best possible resolution on that signal and therefore better control. 

The recommendation is to choose the maximum phase current to be 10% larger than the peak phase 
current of the motor. To convert from rated current, which is typically specified as RMS, to peak current, 
multiply the rated current by the square root of 2.

Once a maximum phase current value has been selected, the current sense resistor and the non-inverting 
differential amplifier gain should be selected so that when the maximum phase current is flowing through 
the sense resistor, it is providing the ADC with 3.3V.

When selecting the current sense resistors, it is important to consider the wattage of that resistor. Since this 
resistor will see a large amount of current flowing directly through it the Ohm’s Law power calculation 
needs to be performed based on the maximum phase current and the chosen resistance. This will determine 
the wattage of resistor to select. If that selected wattage is not available, the circuit can be reworked to 
accommodate part availability.

2.2.3 Gain calibration constants

The gain calibration constants can be used to adjust the overall gain of the ADC feedback signal. They are 
multiplied against the ADC reading. This is an advanced feature that should only be used if you have 
characterized the gain for your ADC circuits. For most applications this value can be left as 1.

2.3 Define PWM settings

The KMS GUI allows you to modify settings for the pulse width modulation (PWM) hardware. Most of 
these settings can be found on the data sheet of the power devices used in your design. This app note uses 
the TWR-MC-LV3PH, HVP-MC3PH, and FRDM-MC-LVPMSM as examples.

In Motor Manager, navigate to the Protection & Hardware tab. On this page there is a section titled 
“Hardware Configurations.” Here you can find the following settings for the PWM hardware.

Figure 8. PWM settings in KMS GUI (default values for FRDM development platform)
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2.3.1 Deadtime

Deadtime is the delay between when the FlexTimer commands the PWM to switch and when the power 
device actually switches. See Figure 9 for an example. Deadtime must be factored into your design. A 
large power device cannot immediately switch between states. If the upper and lower legs of an inverter 
phase are turned on at the same time, a large amount of current is sent through the power devices 
potentially causing catastrophic damage.

Figure 9. Deadtime

In the TWR-MC-LV3PH reference hardware there are two sources of deadtime: the gate drive delay and 
the turn-on/turn-off time of the MOSFET.

The gate drive used is the Freescale Semiconductor 33937A. According to the data sheet (Document 
Number: MC33937), there is a 265 ns delay between the time when a command is issued and the gate drive 
output of 1V. This was found by looking at tONH found on Table 4 in the gate drive data sheet. In Table 4 
there are many different delays listed. In practice, you should use the largest of these delays.

The MOSFET is the International Rectifier IRFR540Z. According to the data sheet, there is 77 ns of delay 
between the time when the MOSFET is commanded to turn off and when it is actually off. This was 
determined by adding td(off) and tf found under Electrical Characteristics. There are separate delays listed 
for the turn-on plus rise and turn-off plus fall. In practice, you want to use the larger of these two.

In the HVP-MC3PH reference hardware, the only source of deadtime comes from the IGBT (Fairchild 
FNB41560). According to the data sheet, the required deadtime is 1.5 us. This was determined by looking 
at tdead under Recommended Operating Conditions.

In the FRDM-MC-LVPMSM reference hardware there are also two sources of deadtime: the gate drive 
delay and the turn-on/turn-off time of the MOSFET.

The gate drive is the Fairchild FAN7888. According to the data sheet there is a required deadtime of 440 
ns. This was found by looking at DT found on the Dynamic Electrical Characteristics in the gate drive data 
sheet.

The MOSFET is the Fairchild FDMS8090. According to the data sheet, there is 41 ns of delay between 
the time when the MOSFET is commanded to turn off and when it is actually off. This was determined by 
adding td(off) and tf found under Electrical Characteristics. There are separate delays listed for the turn-on 
plus rise and turn-off plus fall. In practice, you want to use the larger of these two.



Adapting KMS for Custom Hardware, Rev. 2, 03/2017

12  NXP Semiconductors.

Configuration from KMS GUI

2.3.2 Device models

In order to estimate the amount of voltage across the motor from only the phase current feedback signals, 
the voltage and resistive losses from the power devices must be entered into KMS. There are two primary 
types of power devices used in three phase inverters:

• MOSFET

• IGBT

2.3.2.1 MOSFET

MOSFETs typically require only a resistive loss in order to be modeled correctly. 

The IRFR540Z MOSFET is the power device used on the TWR-MC-LV3PH reference hardware. On the 
data sheet, this is referred to as RDS(on). For the IRFR540Z, the typical value is 22.5 milliohms. 

The FDMS8090 MOSFET is the power device used on the FRDM-MC-LVPMSM reference hardware. On 
the data sheet the resistive loss is called rDS(on). For the FDMS8090, the typical value is 20.0 milliohms.

2.3.2.2 IGBT

The IGBT is the power device used on the HVP-MC3PH reference hardware. IGBTs typically require only 
a voltage loss in order to be modeled correctly. On the data sheet, this is referred to as Forward Voltage. 

For the FNB41560 this is 1.7 V. The addition of a resistive loss will improve the device model used by 
KMS. Refer to the datasheet and application notes from the power device manufacturer.

2.3.3 Device logic levels

Since the output of the MCU is sent into another device that switches power to the motor, the logic 
interface for that device must be considered. This is available on the device data sheet. 

For the 33937A on the TWR-MC-LV3PH reference hardware, the high side inputs are listed as active low 
while the low side inputs are listed as active high in the Pin Definition section of the data sheet. 

For the FAN7888 on the FRDM-MC-LVPMSM reference hardware, all inputs are listed as active high in 
the Logic Input Section (HIN, LIN) of the data sheet.

For the FNB41560 on the HVP-MC3PH reference hardware, all inputs are listed as active high in the 
Integrated Drive, Protection, and System Control Functions section of the data sheet.

NOTE

Toggling polarity in the KMS GUI alone is not sufficient to make this 
change. You must also refer to the KMS source code file pwm_sys.c (see 
Section 3.3.2.1, Set up gate drive logic levels). The function 
FTM_HAL_SetChnOutputPolarityCmd is used by the Kinetis SDK in order 
to establish the gate drive logic levels. This extra step is required because of 
the hardware damage that changing polarity could inflict if set incorrectly. 
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2.4 Define additional settings

In KMS Motor Manager, on the Advanced Tuning page, there are additional settings that might need to be 
configured at this time.

• It is good to provide the name for your custom hardware board so that the saved KMS file reflects 
the hardware that you are using. The field Board Name is provided for your convenience.

• The PWM Frequency establishes the fundamental switching frequency of the inverter.

• The PWM / Fast ISR allows you to run the PWMs at a faster rate than the motor control. This is 
useful for motors that need to be switched at a very high rate. Note that you should not set this 
higher than your inverter hardware’s maximum switching frequency.

• The Fast ISR / Slow ISR establishes how many motor control ISRs should be executed before 
executing a speed control ISR. Running the speed control at 1ms is good for most applications.

2.5 Update motor drive configuration

When you have finished updating your hardware settings, you must push these changes into Motor 
Observer for persistence and usage in your embedded development.

Motor Observer includes a header file, called system.h, that contains motor, hardware, and application 
settings such as those configured in the preceding steps. The file is automatically generated from KMS by 
clicking the Store Motor Information (Figure 10) button located on various Motor Manager pages 
(including the Protection & Hardware page). This automatically updates your reference project with a new 
copy of the file.

NOTE

Manual modification of the system.h file is not recommended. 

Figure 10. Generate system.h header file from button in KMS GUI

3 Configuration from KMS project
The output of the KMS GUI is a reference project consisting primarily of Motor Observer that reflects your 
new system.h file. This project should be adapted in your preferred integrated development environment 
(IDE) for your chosen microcontroller. 

KMS supports the following IDEs:

• IAR Embedded Workbench for ARM (IAR)

• Kinetis Design Studio (KDS)
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Choose either Section 3.1, IAR or Section 3.2, Kinetis Design Studio to make the appropriate MCU 
changes according to a path specific to your IDE. Refer to KMS Release Notes for the supported versions 
of IAR and KDS.

After you have completed your IDE-specific procedure, move to Section 3.3, Specify microcontroller 
configuration to make modifications at the code level independent of IDE.

3.1 IAR

3.1.1 Update Kinetis SDK libraries

KMS relies on the Kinetis Software Development Kit (KSDK) to configure the MCU. Specifically, KMS 
incorporates the KSDK startup and platform libraries into KMS reference projects. As KSDK libraries are 
MCU part number-specific, these must be updated in your KMS reference project for the part you are 
using. The below example uses a KV3x device, but it is the same process for KV1x devices.

To do this, first open your KMS reference project in IAR. The default path for your KMS project IAR 
workspace is:

• C:\Users\<username>\Documents\KMS_<version>\SavedProjects\<platform>_<control 
type>_IAR_<version>\iar\<platform>_<control type>_IAR.eww

For example, a KV3x Tower sensorless velocity control project for IAR may have the following path:

• C:\Users\<username>\Documents\KMS_<version>\SavedProjects\TWRKV31F120M_SNLESSVE
L_IAR_1_0_0_8\iar\twrkv31f120m_snlessvel_IAR.eww

Open the .eww file in IAR, then click to highlight ksdk_platform_lib - Debug at top left.

Figure 11. Highlight KSDK platform library
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In the IAR Project menu, select Remove and click Yes to accept removal

Figure 12. Accept removal of KSDK platform library

Repeat the removal process for ksdk_startup_lib - Debug.

Figure 13. Workspace after removing KSDK libraries for reference hardware

These libraries must be replaced with their analogous versions for the MCU you are using. This document 
assumes that you are switching from the KV31F51212 MCU (resident on the TWR-KV31F120M and 
HVP-KV31F120M reference control boards) to the KV31F25612, a smaller memory variant.

In IAR, go to the Project menu and click to Add Existing Project.... Navigate to your KSDK installation 
location and open the platform library project for KV31F25612. The generic path is:

• <KSDK installation path>\lib\ksdk_platform_lib\iar\<MCU>\ksdk_platform_lib.ewp

An example path is:

• C:\Freescale\KSDK_1.3.0\lib\ksdk_platform_lib\iar\KV31F25612\ksdk_platform_lib.ewp
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Repeat the same process for the startup library.

Figure 14. IAR workspace after addition of new KSDK platform and startup libraries

Change both platform and startup libraries to Release mode using the workspace navigation dropdown.

Figure 15. Change to release mode

Ensure that your IAR license is active, then build the platform and startup libraries by right-clicking on 
each and selecting Make.

Figure 16. Build startup library
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3.1.2 Change device specific settings

Right click on the KMS project file (in this case twrkv31f120m_snlessvel_IAR - Release) and select 
Options. In the General Options section, click the icon and find your MCU part number (in this case 
MKV31F256xxx12).

Figure 17. Select MCU

The include paths and compiler define must be updated to reflect the new MCU. Navigate to the category 
C/C++ Compiler and choose the tab Preprocessor. Manually edit the four instances where the device part 
number is referenced in the include directories. Then edit the defined symbol where the part number is 
referenced (Figure 18).
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Figure 18. Update include directories and defined symbols

Navigate to the Linker category, Config tab, and click to select a different linker configuration file 
(Figure 19). The necessary linker files for different part numbers are included in your KMS reference 
project directory at the same level as the IAR workspace (Figure 20). The default path for the 
KV31F25612 example case is:

• C:\Users\<username>\Documents\KMS_<version>\SavedProjects\TWRKV31F120M_SNLESSVE
L_IAR_1_0_0_8\iar\KV31F256xxx12_flash_KMS.icf
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Figure 19. Click to update linker file
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Figure 20. Select new linker configuration file

While still in the Linker category, navigate to the Library tab and manually update the library paths 
(Figure 21).
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Figure 21. Change library paths

Click OK to exit Options window.

3.1.2.1 Compile and download

Right click on the KMS project file (in this case twrkv31f120m_snlessvel_IAR - Release) and select Make 
to compile.

Make sure the KMS project file is the active project (indicated by bold lettering). If not, right click on it 
and choose Set as Active.
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Use IAR’s Download and Debug command to download code to MCU (Figure 22).

Figure 22. Icon to download and debug

WARNING

If a warning appears indicating that the MCU is secure and asking if you 
would like to mass erase the MCU, select No and investigate the reason this 
warning is appearing. If the MCU is mass erased, KMS secure code is 
removed and the MCU is rendered useless for KMS development.

Wait while code is downloaded (Figure 23).

Figure 23. Flash board

When code is downloaded, click to stop debugging (Figure 24) and move on to Section 3.3, Specify 
microcontroller configuration.
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Figure 24. Stop debugging icon

3.2 Kinetis Design Studio

3.2.1 Update Kinetis SDK libraries

Before using Kinetis Design Studio (KDS) it is important to ensure that the P&E debugger within KDS 
will not cause a mass erase of your MCU. To do this, open KDS and select Help -> About Kinetis Design 
Studio. When that window opens, select Installation Details. Find the entry for GNU ARM PEMicro 
Interface Debugging Support and make sure it is at least version 2.2.9.201512221411 (Figure 25). Click 
the Update... button if not.
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Figure 25. Kinetis Design Studio Installation Details

KMS relies on the Kinetis Software Development Kit (KSDK) to configure the MCU. Specifically, KMS 
incorporates the KSDK startup and platform libraries into KMS reference projects. As KSDK libraries are 
MCU part number-specific, these must be updated in your KMS reference project for the part you are 
using. The below example uses the KV3x device, but it is the same process for KV1x devices.

To do this, first open your KMS reference project in KDS. The default path for your KMS reference project 
file is:

• C:\Users\<username>\Documents\KMS_<version>\SavedProjects\<platform>_<controltype>_KDS
_<version>\kds\

Open KDS and select any workspace or create a new one. Then select Import... from the File menu 
(Figure 26).
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Figure 26. File->Import

Expand “General,” then select “Existing Projects into Workspace” (Figure 27).
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Figure 27. Import existing projects

Click Browse to navigate to your KMS reference project's root directory (Figure 28).
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Figure 28. Select KMS project root directory

Click Finish to add this project into your workspace. Note it is important that you do not click "Copy 
Projects into Workspace." This breaks the file pathing within the KMS firmware.

Repeat this process for the KSDK platform library located at:

• <KSDK installation path>\lib\ksdk_platform_lib\kds\<MCU>

Repeat this process for the KSDK startup library located at:

• <KSDK installation path>\lib\ksdk_startup_lib\kds\<MCU>
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This example assumes the device is the KV31F25612. When completed correctly, the workspace should 
look like the following:

Figure 29. Updated workspace view

Change the platform and startup libraries to Release mode using the Build Configuration option. Highlight 
both projects, right click and navigate to Build Configuration and select release.

Figure 30. Change to release build configuration

Now build both libraries by right clicking on the projects (ksdk_platform_lib_KV31F25612 and 
ksdk_startup_lib_KV31F25612) and select Build Project. Ensure that the KSDK libraries both build 
successfully.

3.2.2 Change device specific settings

Right click on the KMS project file (in this example: twrkv31f120m_snlessvel_KDS) and select 
Properties. The include paths and compiler define must be updated to reflect the new MCU. Navigate to 
the Cross ARM C Compiler -> Preprocessor settings to change the predefined MCU symbol to your 
selected MCU (Figure 31).
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Figure 31. Change preprocessor settings to appropriate device

Select Cross ARM C Compiler -> Includes and manually edit the instances where the part number is 
referenced (Figure 32).
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Figure 32. Manually edit include paths

In addition to the compiler settings, the linker settings must also be modified. The linker file needs to be 
changed to support the new selected device. The necessary linker file for different part numbers are 
included in your KMS reference project at the same level as the KDS project file. Navigate to Cross ARM 
C++ Linker -> General and modify the linker file entry to reflect your new device (Figure 33).



Adapting KMS for Custom Hardware, Rev. 2, 03/2017

NXP Semiconductors  Adapting KMS for Custom Hardware

Configuration from KMS project

Figure 33. Modify linker file

Within the Cross ARM C++ Linker category, select Libraries and manually update the library paths 
(Figure 34).
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Figure 34. Manually edit library paths

Click OK to exit.

3.2.3 Compile and download

Right click on the KMS project file (in this example: twrkv31f120m_snlessvel_KDS) and select Build 
Project. Ensure that the project compiles successfully. Now that the project is compiled, it needs to be 
downloaded to the target device.

Click on the Debug dropdown and select Debug Configurations.

Figure 35. Select debug configurations
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Select your debugger, in this case it is GDB PEMicro Interface Debugger. Double click the GDB PEMicro 
Interface Debugger. Under the Debugger tab, set the Interface for OpenSDA Embedded Debug - USB Port 
(Figure 36).

Figure 36. Select proper debugger and interface
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Next select the device that you are using (Figure 37).

Figure 37. Select appropriate MCU

WARNING

At bottom of Debugger tab, ensure that Mass erase on connect is NOT 
checked. This is critical because mass erase removes preprogrammed KMS 
code on the MCU that cannot be restored in the field.

Figure 38. Prevent mass erase on connect

Click Apply then Debug. Kinetis Design Studio will download your project to the target and begin to run 
the debugger. When finished, click to stop the debugging (Figure 39).
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Figure 39. Click to stop debugging

3.3 Specify microcontroller configuration

Now that the reference project has been updated with your motor and hardware settings, you need to ensure 
that the correct pins and clocks are being used. Motor Observer relies on specific hardware modules inside 
the MCU to control the motor (FlexTimer & ADC), communicate with KMS (UART), and communicate 
with the gate driver (SPI) [optional].

3.3.1 Modify clock configuration

On custom hardware the microcontroller clock may not be the same as is used on the reference hardware. 
The microcontroller clock configuration is established in the hw_pins_init.c file. The Sub-Family 
Reference Manual for your specific microcontroller contains all of the required details to establish your 
clock configuration. Kinetis SDK 1.3 is used to access the clock registers. This will also handle knowledge 
of the clock frequency by the other peripherals. In order to maximize performance of Motor Observer the 
fastest possible clock should be used. 

3.3.2 Modify FlexTimer pins

The FlexTimer drives the PWM signals into the inverter circuit. The FlexTimer is configured in the 
pwm_sys.c file. The functions in this file are called by the SVPWM block. Use Kinetis SDK 1.3 to access 
the FlexTimer registers. FlexTimer 0 is used by all members of the KV3x and KV1x families for motor 
control.

The default pins used for the FlexTimer are specified in Table 3.
Table 3. FlexTimer Pins

FlexTimer Channel KV3x Pins KV1x Pins

FTM0_CH0 PTC1 PTC1

FTM0_CH1 PTC2 PTC2
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NOTE

The same pins are used for the TWR-MC-LV3PH, HVP-MC3PH, and 
FRDM-MC-LVPMSM.

All pins in the KMS reference project are modified in the hw_pins_init.c file. The function PINS_init is 
used to configure the pin mux for these pins. The specific mux configuration for all pins can be found in 
Section 10.3 Pinout of the Sub-Family Reference Manual for your specific microcontroller.

3.3.2.1 Set up gate drive logic levels

The FlexTimer logic levels need to be aligned with the expected logic levels of the gate drive. The Kinetis 
SDK function FTM_HAL_SetChnOutputPolarityCmd sets the output polarity of specific channels for the 
FlexTimer. This is called as part of the PWMS_init function located in the pwm_sys.c file. 

On the TWR-MC-LV3PH, the 33937A gate drive has active low inputs for the high side and active high 
inputs for the low side. This is found by looking at the functional pin description for the high side inputs 
pins and the low side input pins.

On the FRDM-MC-LVPMSM, the FAN7888 has active high inputs for both high side and low side. This 
is found by looking at the logic input section.

On the HVP-MC3PH, the FNB41560 has active high inputs for both high side and low side. This is found 
by looking at the input interface description.

3.3.2.2 Set up fault input pin

The FlexTimer has fault inputs that halt PWM generation. If your power hardware has this option refer to 
the Sub-Family Reference Manual for information about how to configure the fault input.

The HVP-MC3PH reference hardware features a fault output that is asserted on under-voltage lock out 
condition or on a short circuit. The pin used to interface with the FNB41560 is specified in Table 4.

FTM0_CH2 PTC5 PTC3

FTM0_CH3 PTC4 PTC4

FTM0_CH4 PTD4 PTD4

FTM0_CH5 PTD5 PTD5

Table 4. FNB41560 interface pins

Signal KV3x Pin KV1x Pin

Fault (MCU Input) PTA19 PTC0

Table 3. FlexTimer Pins

FlexTimer Channel KV3x Pins KV1x Pins
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3.3.3 Modify ADC pins

The ADC is used to measure the phase current feedback as well as the DC bus voltage. The ADC module 
is configured in the adc_sys.c file. An additional file called feedback_3ph.c converts the raw ADC 
readings into usable signals.

The functions in the adc_sys.c file are called by the FEEDBACK block. The adc_sys.c file uses Kinetis 
SDK 1.3 to access the ADC registers. Both ADC 0 and ADC 1 are configured for use by Motor Observer. 
There is a mechanism to allow for additional ADC samples to be taken. This is discussed in 
Section 3.3.3.3, Making additional ADC measurements.

On the KV3x and KV1x families of microcontrollers there are two ADC modules, each of which can 
sample two channels back to back. Motor Observer has configured the modules to allow all motor control 
signals to be sampled in each ISR (Table 5 and Table 6).

Table 6. KV1x ADC modules and sampling

Different sampling patterns are discussed in Section 3.3.3.1, Mapping ADC measurements to motor 
control signals.

Pins used for the ADC on the development platforms are outlined in Table 7.

Table 5. KV3x ADC modules and sampling

ADC 0 ADC 1

Sample A A Phase Current B Phase Current

Sample B DC Bus Voltage C Phase Current

ADC 0 ADC 1

Sample A B Phase Current A Phase Current

Sample B DC Bus Voltage C Phase Current

Table 7. ADC pins

Development platform Measurement

Power stage Control board
A phase 
current

B phase 
current

C phase 
current

DC bus voltage

FRDM-MC-LVPMSM FRDM-KV11Z ADC1_SE1 ADC0_SE9 ADC1_SE7 ADC0_SE5

FRDM-KV31F ADC0_SE8 ADC1_DP0 ADC1_DP3 ADC0_SE13

TWR-MC-LV3PH TWR-KV11Z75M ADC1_SE1 ADC0_SE12 ADC1_SE7 ADC0_SE13

TWR-KV31F120M ADC0_SE8 ADC1_DP0 ADC1_DP3 ADC0_SE13

HVP-MC3PH HVP-KV11Z75M ADC1_SE4 ADC0_SE9 ADC1_SE7 ADC0_SE4

HVP-KV31F120M ADC0_SE8 ADC1_DP0 ADC1_DP3 ADC0_SE12
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Once you know the pins for your measurements, map them to the correct ADC channels. The channel 
information configures the ADC so it knows which channel to sample. The information for this mapping 
is located in Section 3.7.1.3 ADCx Connections/Channel Assignment of the Sub-Family Reference 
Manual for your specific microcontroller.

For the TWR-KV31F120M and TWR-MC-LV3PH, combining the two previous tables with the channel 
mapping from the KV3x Sub-Family Reference Manual results in the sampling pattern described in 
Table 8.

This sampling pattern is in the adc_sys.c file. Since there are multiple points in the adc_sys.c file where 
the channel must be set, four macro definitions have been provided to make it easier to adjust the relevant 
channels. The macro definition structure is defined as follows:

ADCx_SAMPLEy_CHANNEL

Where:

x is the ADC instance (0 or 1) 

y is the sample (A or B)

Update these macro definitions with the channels that you need to sample.

3.3.3.1 Mapping ADC measurements to motor control signals

The Motor Observer reference project assumes the motor control sampling pattern specified in Table 9 and 
Table 10.

Table 10. KV1x motor control sampling pattern

It is important to note that this sample pattern is done out of convenience. Different sampling patterns can 
be accommodated in the adc_sys.c file. The function ADCS_readRawADC maps the ADC module and 

Table 8. ADC sampling pattern for TWR-KV31F120M and TWR-MC-LV3PH

ADC 0 ADC 1

Sample A 8 0

Sample B 13 3

Table 9. KV3x motor control sampling pattern

ADC 0 ADC 1

Sample A A Phase Current B Phase Current

Sample B DC Bus Voltage C Phase Current

ADC 0 ADC 1

Sample A B Phase Current A Phase Current

Sample B DC Bus Voltage C Phase Current
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sample to the motor control signal that it represents. This function should be modified so that the ADC 
result is assigned to its motor control signal.

3.3.3.2 Using two phase current sensors

Motor Observer supports usage of two phase current sensors instead of the default configuration of three. 
To enable this mode, replace feedback_3ph.c with feedback_2ph.c and exclude the former from your 
project build.

Utilize Table 7 and surrounding instructions to ensure that Motor Observer has the proper ADC 
assignments.

If the two phase currents you are sensing are not Phase A and Phase B (as is assumed in feedback_2ph.c), 
review the current reconstruction examples and offset calculation included in feedback_3ph.c and adapt 
feedback_2ph.c to reflect your desired reconstruction. For example, if you are sensing Phase A and Phase 
C, and thus need to reconstruct Phase B, copy the code that calculates this configuration from 
feedback_3ph.c and replace the code in feedback_2ph.c that assumes reconstruction of Phase C.

NOTE

Using only two phase current sensors limits overmodulation performance.

3.3.3.3 Making additional ADC measurements

Since both ADC modules are being used for motor control, any additional ADC channel sampling must 
be scheduled in-between the motor control samples. This mechanism is built into the reference project. 

The code to set up these additional samples runs at the same frequency as the motor control. After 
processing the motor control sample, the current index of the user ADC channels is configured to be 
sampled. Then the motor control software is executed, after which the results from the user ADC channel 
is stored in the results buffer (adcxResults, where x is the ADC instance [0 or 1]). The ADC is then 
reconfigured for motor control sampling.

To configure this code, three things need to be set in the main.c file.

1. The macro definition for NUMBER_USER_ADC_CHANNELS should be set to the total number 
of ADC channels you want to sample on one of the ADC converters. For example, if you wish to 
sample two channels on ADC 0, this would be set to 2. If you want to sample one channel on ADC 
0 and one channel on ADC 1, this would be set to 1.

2. The arrays adcUserChannelsChannelx (where x is the ADC instance (0 or 1)) identify the 
channels that you wish to sample. This array represents the round-robin list of channels where one 
is sampled per ADC converter during each ISR.

3. This additional ADC sampling is enabled or disabled using a static variable called 
bEnableRoundRobinAdc. This variable needs to be set to true in order for these additional ADC 
channels to be sampled.
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3.3.3.3.1 Example Configuration

If you want to sample two channels (23 and 24) on ADC 0 and one channel (12) on ADC 1 and sample 
channel 23 on ADC 0 twice as fast as channel 24. This can be easily configured using the code in 
Figure 40.

#define NUMBER_USER_ADC_CHANNELS (3)

static const bool bEnableRoundRobinAdc = true;

static const uint16_t adcUserChannelsChannel0[NUMBER_USER_ADC_CHANNELS] = {23, 24, 23};

static const uint16_t adcUserChannelsChannel1[NUMBER_USER_ADC_CHANNELS] = {12, 12, 12};

Figure 40. Sample code for ADC example

This establishes different sampling rates for different signals.

3.3.4 Modify UART pins

The UART used to communicate between KMS GUI and Motor Observer is configured in the 
hw_pins_init.c file. The functions in this file are called by the main source file during initialization. This 
file uses Kinetis SDK 1.3 to access the UART registers. UART 0 is used to support all members of the 
KV3x and KV1x families.

By default, the pins outlined in Table 11 are used for the UART.

NOTE

The same pins are used for the TWR-MC-LV3PH, the HVP-MC3PH, and 
the FRDM-MC-LVPMSM.

The pin mux is configured in the PINS_init function located in the hw_pins_init.c file. The specific mux 
configuration for all pins can be found in Section 10.3 Pinout of the Sub-Family Reference Manual.

KMS expects the serial communication to have the configuration described in Table 12.

Table 12. Serial communication configuration

Deviation from these settings is not advised.

Table 11. UART pins

Pin Signal

PTB16 UART0_RX

PTB17 UART0_TX

Baud Rate
115200 (KV3x
57600 (KV1x)

Data Bits 8

Parity None

Stop Bits 1
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3.3.4.1 Disabling KMS and Motor Observer communication

By default, Motor Observer does not allow the motor to run unless it is connected to the KMS GUI. This 
feature may be disabled. If the variable commTimeOutEnabled (in the main.c file) is set to false, Motor 
Observer runs without the KMS connection.

3.3.5 Modify gate drive interface [optional]

Some gate drives have an interface for configuration or fault reporting. This interface is typically 
comprised of GPIO pins and possibly a SPI interface.

The 33937A gate driver on the TWR-MC-LV3PH features a GPIO and SPI interface. Motor Observer can 
interface with this gate driver. If you use the same gate driver, you can use the Motor Observer interface 
software. If you use a different gate drive, you must update the interface software to work with your gate 
drive.

By default, the pins specified in Table 13 are used to interface to the 33937A gate drive.

The pins used for the SPI interface and GPIO interface are configured by the PINS_init function in the 
hw_pins_init.c file. The specific SPI module and GPIO pins used need to be registered with the 33937A 
interface software. This is done by the SAC_Driver3PhInit in the driver3ph_mc33937.c file. 

3.3.6 Compile and download firmware

Now that the hardware interface has been defined, compile the reference project and download it to the 
microcontroller. 

WARNING

Do not mass erase the microcontroller. If the microcontroller is mass erased, 
Motor Observer firmware in an execute-only section of the microcontroller 
is erased and cannot be restored.

Table 13. Gate driver interface pins

Signal KV3x Pin KV1x Pin

SPI0 CS PTE16 PTC0

SPI0 SCK PTE17 PTC5

SPI0 OUT PTE18 PTD2

SPI0 IN PTE19 PTD3

Enable (MCU Output) PTA5 PTE29

Reset (MCU Output) PTC7 PTA20

Interrupt (MCU Input) PTB18 PTE30

Overcurrent (MCU Input) PTC9 PTB2
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In addition, new flash commands have been added. One of these is "Erase 
All Execute-only Segments" (Flash command 0x4B). This command should 
never be executed as it would erase the KMS library and render the MCU 
non-functional for KMS operations.

4 Verification from KMS GUI

4.1 Verify DC bus and offsets

After the firmware is downloaded to the microcontroller, connect the KMS PC GUI to the MCU. The 
firmware validates the ADC measurements on startup.

4.1.1 Phase current offset

Motor Observer runs a calibration routine on the phase current feedback that averages the ADC value 
when no current is flowing through the resistor. This value is subtracted from the ADC reading in order to 
measure both positive and negative phase currents. This value should be 2048, which indicates that there 
is a 1.65V offset so that the phase current measurement is zero-centered.

An error is generated if the offset value is too far from the ADC midpoint. An offset error typically 
indicates an issue with either the ADC pin, the phase current sensing hardware, or the offset generation. 

4.1.2 DC bus voltage

After the ADC calibration, Motor Observer waits a set amount of time for the DC bus to settle. During this 
time, the Drive State Machine resides in the Start state.

Typically, an over or under voltage fault immediately after startup indicates that there is an issue with the 
ADC pin. The value of the DC bus can be viewed from the Motor Manager Dashboard. If this value is not 
the DC bus value that you expect, then there is an issue with the DC bus scaling.

4.2 Verify PWM operation

Before driving current through a motor, you must validate that the PWM signals are as expected. It is best 
to do this without a motor. The drive can be placed into an open-loop voltage mode where the d and q 
voltage references can be commanded directly. An oscilloscope can be connected on the PWM drive signal 
to confirm that the signals coming out of the microcontroller are what you expect.

1. Open KMS and connect to the microcontroller

2. Click to open the Watch Window (Figure 41)

Figure 41. Watch Window button
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3. Click to begin adding a variable into the Watch Window (Figure 42)

Figure 42. Add button

4. Select “user.state”, and add it to the Watch Window (Figure 43). This variable controls the state of 
the drive.

Figure 43. Add “user.state”
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5. Add “user.command.statorRefVoltage.d” and “user.command.statorRefVoltage.q” into the Watch 
Window and set the scalings according to Figure 44. These variables are the references that you 
set to the drive.

Figure 44. Drive reference voltages and scaling

6. Add “svpwm.output.drivePwmA”, “svpwm.output.drivePwmB”, and 
“svpwm.output.drivePwmC” into the Watch Window and set the scalings according to Figure 45. 
These variables are the duty cycles that are sent out via the PWM module.

Figure 45. PWM duty cycles

7. Set “user.state” to 5; this places the drive into voltage mode. The PWM signals should be at 50% 
duty on the oscilloscope.
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You can vary the amount of duty cycle by increasing or decreasing the value of 
“user.command.statorRefVoltage.d” or “user.command.statorRefVoltage.q”.   

NOTE

These variables are in terms of modulation. So 1.0 represents the high side 
on 100% of the PWM period, -1.0 represents the low side on 100% of the 
PWM period, and 0.0 represents the 50% on both the high and low side. 

It is important to verify two things about each pin:

• Correct Pins

— Example: make sure that svpwm.output.drivePwmA is applied to phase A

• Duty Cycle

— Example: make sure that the duty cycle in svpwm.outputdrivePwmA matches the duty cycle 
on phase A

It is important to validate not only that the duty cycle generation is correct, but also that the deadtime is 
correct. In order to validate the deadtime you should measure the PWM drive signal for both the high side 
and the low side simultaneously to ensure that the deadtime is being inserted correctly.

4.3 Verify phase currents

The simplest way to verify the phase current is by measuring motor parameters. This injects DC current 
into the motor, and is a simple way to validate the feedback signals. Make sure that a motor is connected 
to the system for this step.

1. Navigate to the Expert Identify page in Motor Manager.

2. Make sure the Basic Motor Parameters are configured for your motor.

3. In the Automatic Parameter Measurement step, set Enable Rotation to Disable (Figure 46). This 
only does the DC injection steps of parameter identification and does not try to rotate the motor.

Figure 46. Disable rotation

4. Open a Plot by clicking the Software Oscilloscope button (Figure 47)
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Figure 47. Software Oscilloscope button

5. Select Phase Currents from the drop down list of preconfigured plots (Figure 48)

Figure 48. Phase current plot selection

6. Click the Play button to begin sampling, then switch back to Motor Manager and click Start 
Motor Measurement (Figure 49)

Figure 49. Start motor measurement button

7. KMS prompts you to confirm that you wish to disable rotation during parameter identification 
(Figure 50). KMS may also ask if you wish to return identification values to defaults. Click Yes 
for both.

Figure 50. Confirm that rotation is disabled
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8. Once the Motor Parameter Identification is complete, the plot window should look similar to 
Figure 51.

Figure 51. Phase current plot output

9. Stop the plotting, so that you can interact with the feedback.

The current on phase A should be equal to the following equation

Rated Current * sqrt(2) * 0.8 Eqn. 8

The current on phase B and C should be half and negative of the value on phase A

If the values of current are different than you expect, you should revisit the ADC settings or the phase 
current sensing hardware settings (see Section 2.2, Define ADC settings and Section 3.3.3, Modify ADC 
pins).

4.4 Spin your motor on your own hardware

Once the feedback currents and voltage, and the PWM drive signals have been verified, you are ready to 
spin your motor on your own hardware. Revisit the Motor Tuner steps to ensure that everything is working 
correctly.

WARNING

As you complete prototyping on custom hardware and move into production 
programming, remember to inform those responsible for programming 
to avoid mass erase in order to preserve KMS proprietary code.
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5 References
Please see the below documents for additional information about the Kinetis KV3x & KV1x MCUs, and 
Kinetis Motor Suite.

Kinetis KV3x Documentation

• MCU Datasheets

— Kinetis KV31: 120MHz Cortex-M4F 512KB Flash (64/100pin): KV31P100M120SF7

— Kinetis KV31: 120MHz Cortex-M4F 256KB Flash (64/100pin): KV31P100M120SF8

— Kinetis KV31: 100MHz Cortex-M4F 128KB Flash (64/100pin): KV31P100M120SF9

— Kinetis KV30: 100MHz Cortex-M4F 64/128KB Flash 32-64pin: KV30P64M100SFA

• MCU Reference Manual

— Kinetis KV31: 120MHz Cortex-M4F 512KB Flash (64/100pin): KV31P100M120SF7RM

— Kinetis KV31: 120MHz Cortex-M4F 256KB Flash (64/100pin): KV31P100M120SF8RM

— Kinetis KV31: 100MHz Cortex-M4F 128KB Flash (64/100pin): KV31P100M100SF9RM

— Kinetis KV30: 100MHz Cortex-M4F 64/128KB Flash 32-64pin: KV30P64M100SFARM

• Mask Set Errata for Mask 0N36M-Errata: KINETIS_V_0N36M

Kinetis KV1x Documentation

• MCU Datasheets

— Kinetis KV11: 75 MHz Cortex-M0+ 64/128 KB Flash (32-64 pin): KV11P64M75

• MCU Reference Manual

— Kinetis KV11: 75 MHz Cortex-M0+ 64/128 KB Flash (32-64 pin): KV11P64M7RM

• Mask Set Errata for Mask 0N63P

— Errata: KINETIS_V_0N63P

Kinetis Motor Suite Documentation

• Kinetis Motor Suite Release Notes: KMSRN

• Kinetis Motor Suite User Guide: KMSUG

• Kinetis Motor Suite Lab Guide: KMSLG

• Kinetis Motor Suite API Reference Manual: KMSRM
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6 Revision history
Table 14 provides a revision history for this document.

Table 14. Revision history

Rev. number Date Substantive change(s)

2 03/2017  • Updated KMS 1.0.1 to KMS 
1.1.0. Primary change is 
addition of support for KV1x 
MCUs.

1 08/2016  • Updated KMS 1.0.0 to KMS 
1.0.1

 • Updated default path for KMS 
project IAR workspace to reflect 
current version.

 • Added KV3x-specific device 
information.

0 02/2016  • Initial release
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